Installing and Configuring Horizon TRUESSO

Overview

€ Traditionally when authenticating to Workspace ONE Access using a 3rd party
authentication method, the user we will by default, not have a Single-Sign On
experience when trying to launch any VMware Horizon based resource through
Workspace ONE Access.

Traditionally when using a password based authentication method Workspace ONE
Access would cache the original authentication against Access and then pass this on
when required to the Broker.

Traditionally Single-Sign On would only be an issue when using a 3rd Party
authentication method. To solve this problem we would deploy what is known as the
Horizon Enrollment services to facilitate a single-sign on experience. We integrate with
Microsoft Certificate Services to provide a solution to this challenge and we refer to the
solution as Horizon TRUE SSO

Since December 2019

When connecting to Horizon Resources via Workspace ONE Access. Caching of
Passwords for Horizon has been disabled by default for SAAS, and a user will have to
re-authenticate when they select their entitlement. Whilst the session is open we can
choose to Cache the users credentials provided the Authentication method is
password based.

https://docs.vmware.com/en/VMware-Workspace-ONE-Access/services/rn/VMware-
Workspace-ONE-Access-Cloud-Release-Notes.html

To continue offering users a seamless single-sign On experience, Enrollment services
has now become a critical service with the integration with Workspace ONE Access

In this lab scenario the 3rd party authentication method we use to login into
Workspace ONE Access will be a certificate based method of authentication.

We will start off by doing the following:

1. Configure Windows 10 for Certificate Based Authentication using Workspace ONE UEM
2. Configure Workspace ONE Access for Certificate based Authentication
3. Loginto a Windows 10 Desktop and demonstrate the limitation
4. Deploy and configure TRUE SSO
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+ Deploy and configure Horizon Enroliment services
* Integrate and configure Active Directory Certificate services with Horizon
Enrollment services

5. Log into a Windows 10 Desktop and demonstrate the solution

Part 1: WorkspaceOne UEM - Certificate Profile

23

Workspace ONE™ UEM

Username

rogea farlane@gmail.com

[l Remember

Trouble logging in

1. Switch to your custom UEM Saas Tenant
* If necessary, authenticate using your Saas Admin credentials
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Settings Livefire

System  »  Enverprise Integration

Getting Started

~ Enterprise Integration
e

Workspace ONE Access

Server
Certificate autharities
Content Gateway Estabdish trust between users, devices and the hyl
apps.

Cloud Connector .
Direcrory 5ervices URL
Emazll {SMTP)
Whtware Tunn| Admin Lissrramy
Whiware Tunnel Progy

Acthve Directory Basic ENA

* Peer Distribution

Third-Party Procies _

Basic User Sync

.
z
=

SMS

Pull service Installers

h Use this Actian Buman o update Warkspace OF
* Workspace ONE Acoess
USE AUTOGEMERATED API KEY
Configuration

* Securiny

Certificate
Help
e Enizble Warkspace ONE UEM certificate provision
* Localization trust with Workspace ONE Access authentication §

Tarmes af L ica

2. Inthe Workspace ONE UEM Admin Console
* Navigate to Groups & Settings > All Settings > System > Enterprise Integration >
Workspace ONE Access > Configuration

Certificate

Enable Workspace ONE UEM certficate provisioning for use with Workspate ONE Access and
Mebile S50. Export the issuer certificate on this page so that you can establish trust with
Workspace ONE Access authentication adapters
Certificate Type Pfe
Walid Fro... 51672020
Valid Te  5/18/2040
Thumbp... BEC33DCE0D225BD01 B536ADEEABATI1AD2SIEEBID

Issuer Certificate

DELETE

FUl 2T VILT IHIDw3ainei

Bl vidmairwatchRoot...cer A

3. Click EXPORT in the Certificates section on the Workspace ONE Access page
+ Note this will download a .cer file (VidmAirWatchRootCertificate.cer)
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+ Select X to close the Settings window

& dw-livefire.awmdm.com,

A 5] ®
&
GETTING Dashboard Devices » Profiles & Resources
N List View
Profiles
Drevice Updates
=
WENToR Lifecycle > Filters ADD v
Profiles & Resources 4 Profile Detail *ayloads
7 Android 1
Baselines ) VPN
. Resources
e
e Batch Status

HorizoniNTRN

shboard Devices » Profiles & Resources
tView H
Profiles
vice Updates
acycle > Filters DD

sfiles & Resources w

laselines

4. From the UEM Console
* Navigate to Devices > Profiles & Resources > Profiles
 Select > ADD > Add Profile

Add Profile

Select a platform to start

Select Device Type

Select Context

5. In the Add Profile window
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+ Select Windows > Windows Desktop > User Profile
* Next to Name* enter: W10 - SCEP - SSO.

SNV Y > -

demale.striteo

#° All Devices (demale. striteo) b4

Start typing to add a group Q

l VIEW DEVICE ASSIGMMENT ‘

6. Still in the General tab,
+ Scroll down to Smart Groups
+ Select All Devices(YOUR SAAS Tenant)

General
VPN
Credentials

Windows Hello

SCEP
Single App Mode
[ ]
Exchange ActiveSync
Exchange Web
Services
7. Now navigate to the SCEP tab on the left menu
* Select CONFIGURE
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Find Payload ‘

General

VPN

Credentials
Windows Hello
Single App Mode
Web Clips

Exchange ActiveSync

SCEP Q)

=& Add a New Windows Desktop Profile

SCEP

Credential Source
Certificate Authority *
Certificate Template *

Key Location

SAVE AND PUBLISH CANCEL

AirWatch Certificate Authority

AirWatch Certificate Authority

Single Sign-On

Software

8. Set the following:

+ Credential Source: AirWatch Certificate Authority

+ Certificate Template: Single Sign-On
+ Key Location: Software

*+ Click SAVE AND PUBLISH at the bottom right of the window
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9. Confirm your device is shown in the View Device Assignment page
+ Select PUBLISH

Part 2 : Configure Workspace ONE Access

Select Your Domain

System Domain v

[J Remember this setting

vmware

1. Switch to your custom Saas Workspace ONE Access tenant
* If necessary, authenticate as System Domain, select Next
+ Sign in with your Admin credentials for your Saas Tenant
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#  aw-Ivefirehodzoningn. vidmpee, W C O

. )

@ ‘Waorkspace OMNE™ Access

Dashbosrd = | Users & Groups | Catalep -  (ETUEINE I EETCRY SRR

Diretories  Identily Prosiders  Possword Resosery Assistant  Authenlication Methads  Foliokes

Authentication Mathads lor Built-in ldentity Providers

mpnelan|: When you deashin an milbanticaion method, the authsmication methd s removesd as a cholcs in 1t acoses policy nobes pags, Maks surs you epdals the socee policy nbes In ssksct s
Sathenticaton Methoss Canfguee Blates

Fisk Sonew ra Heablad

Vhitwar Werify F Ciaablad

Wobe S50 for 05 4 Haablad

Fassword (Local Direciory] F Enailed

Wiohin S50 Jor Andnoid J o

Toker Auth Acamier F Cisablad

Workepacs DHE UER External Acoess Toker F skl
Davice Compliance [with 'Workspaos OKE UEM F Cisablad
Prapwnnd (Wit Workspacs ONE LER) ra Haablad

— o

2. Inthe Access admin console
+ Navigate to ldentity & Access Management > Authentication Methods.
+ Select the pencil icon next to Certificate (Cloud Deployment)

Cerfificale (Cloud Deployment)

Enable Certificate
Adapter

Root and intermediate CA Select Flle
certificates®

Uploaded CA Certificates  Ch =L ivefire (90 3FTER2FT 15604947 164940 EEBFG3394B85TOSB2ET23AE2TS 1 TOFSES3S386EF) ¢

User ldentifier 5earch
Order

upn | Subpect

Walidate |IDM Earmat o

an

B
B sig
B

VidmairWatchRootCertificate (1).cer

Cancel

3. In the Certificate (Cloud Deployment) page click the tickbox to Enable Certificate
Adapter
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* Click Select File for the Root and Intermediate CA Certificates

« Select the certificate (VIDMAirWatchRootCertificate.Cer) we have downloaded from the
UEM console earlier and

« Select Open

Update Auth Adapter

Please click OK to confirm and upload file.

Certificate (Cloud Deployment)

certificates®

Uploaded CA Certificates

User Identifier Search
Order

Validate UPN Format

Request Timeout

You can upload muliiple DER and PEM root and intermediate CA cerfificates including concatenated PEM files

CN=Livefire (9C3F7E62F73568A9AT73649A0EEBF63394B86705B2E723AE2T5170F5E939386EF) %
upn | subject v

Select the search order for locating the user identifier within the certificate. upn: UserPrincipalName value from
the Subject Alternative Name; email: Email address from the Subject Alternative Name; subject: UID value from
the Subject

v

Validate the format of the UserPrincipalName field
0

Timeout in seconds to wait for a response. A value of zero will wait indefinitely.

Cancel

4. Once the certificate has uploaded select OK.
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® Workspace ONE™ Access

Dashboard - Users & Groups Catalog ~ Identity & Acocess Management Roles

Directories ldentity Providers Pas word Recovery Assistant Authentication Methods Policies

Enterprize Auti

Identity Providers (4)

Identity Provider Name Auth Methods

Directory
System |dentity Provider Paseword (Local Directory) System Directory
ﬁe”iﬁwtﬂ I.I:qu'u UEDIQ?ment}
Sl Ll L Password (cloud deployment) Livefire Sync
IDF for corpPiv.local Fassword (cloud deployment) corpPriviocal
5. Inthe Workspace ONE Access Console
+ Under Identity & Access Management
 Select Identity Providers
* Select Built-in
<Back to IdP List
Identity Provider Name Built-in
Q
g Users Select which users can authenticate using this IdP. Choose from the available directories from the list
below.
System Directory
Built-in + | LivefireSync
Type: EMBEDDED corppriviocal -
Status: Enabled 1 »
KDC Certificate Export Download Cerlificate
Export the KDC server root certifici
ﬁ Cancel
6. In the Built-In Identity Providers window
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* Inthe Users area
*+ Notice checkbox for LivefireSync is select but not corppriv.local
+ Select the checkbox next to corpriv.local

* In the Authentication Methods area
+ Select the checkbox next Certificate (cloud deployment)

+ Select Save at the bottom of the page.

® Workspace OMNE™ Access

Dashboard -~ Users & Groups Catalog ~ Identity & Access Management

Directories

Identity Providers Password Recovery Assistant Authentication Methods Palicies

ADD POLICY EDIT DEFAULT POLICY | | NETWORK RAMGES
Pallcy Name Applies to
APP_S50 Policy 2 Application(s)

* default_access_policy_set 4 Application(s)

7. In the Workspace ONE Access Admin console
+ Navigate to Identity & Access Management > Policies
+ Select the radio button next to default_access_policy_set

@ Workspace ONE™ Access

Dashboard ~ Users & Groups Catalog

Directories Identity Providers Password Re

Policy Name
0 APP_S50 Policy

o default_access_policy_set
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8. In the Policies area
+ Select EDIT

Edit Policy

1 Definition
2 Configuration

3 Summary

You can create a list of rules to access the applications sele
of devices that can access the applications, the auth meatho
application before reauthenticating

Metwork Range Device Type

4 ALL RAMGES Web Browser

4 ALL RANGES Waorkspace ONE App

% ADD POLICY RULE

9. In the Edit Policy window,

+ Select, the second header, from the left column Configuration

+ Select All Ranges next to Web Browser,

£ CONFIGURATION

If a user's network range is *

and the user accessing content from *

and user belongs to group(s)

Then perfarm this action
then the user may authenticate using *
If the preceding method fails or is not applicable, then

If the preceding method fails or is not applicable, then

-

CANCEL SAVE

Edit Policy Rule

ALL RANGES
‘Web Browser
"_) Select Groups,

Rule applies to all users if no group(s) selected.

Authenticate using...

Certificate (cloud deployment)

Password (cloud deployment)

Password (Local Directory)

(#) ADD FALLBACK METHOD

10. In the Edit Policy Rule window
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* Next to then the user may authenticate using * to select Certificate (Cloud
Deployment)

+ Next to if preceding method fails or is not applicable, then * select Password (Cloud
Deployment),

 Select ADD FALLBACK METHOD

+ Next to if preceding method fails or is not applicable, then * select Password (Local
Directory)

+ Select SAVE at the bottom of the window

You can create a list of rules to access the applications selected. For each rule, select tf
of devices that can access the applications, the auth methods, and the maximurm numi

application before reauthenticating.

Metwork Range Device Type Authentication

2 ALL R&AMGES Web Browser Certificate (cloud depl...

Workspace OME App Password (cloud deplo..
t} ADD POLICY RULE
11. In the Edit Policy Rule window
« Select ADD POLICY RULE
Edit Policy Rule
It & user’s network range 5 © ALL RANGES .
and user accessng content from -~ Windows 10
and user belongs 10 group(s)
Then parfarrm this action Authensicste using
then the wser may authenicate using * Certficats (Cloud Deplioyment)
H the preceding method falls or is not applicable, then Prassword {cloud deployment)
W the preceding method falls or is not applicable. then Pagsword (Lotal Directory)
ADD FALLBA E
Re-authenticale atter * - Hours
o)

12. Select Windows 10 from the user accessing content from drop down.
+ Select Certificate (Cloud Deployment) for the first authentication method
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+ Select Password (cloud deployment) for if the preceding method fails ...

+ Select Password (Local Directory) for if the preceding method fails ...
+ Click SAVE at the botom right hand side of the page

Network Range
i ALl RAMNGES

i ALL RAMNGES

LL RAMGES

¥ ADD POLICY RULE

Network Range
i ALL RAMGES
i ALL RAMNGES

i ALL RAMGES

Device Type

Workspace ONE App ...

Web Browser

Windows 10

Device Type

Windows 10

Workspace OMNE App ..

Web Browser

13. Next to ALL RANGES for Windows 10 on the left select the 6 DOTS and drag to the top
+ Select NEXT on the Edit Policy Page

Edit Paolicy

1 Depliswiticn
I Canfiguration

3 Sumnmary

Definition
N
defaull_acoess_policy_set

Eescription
Defauk access policy set

applcations
4 Application{s]

Configuration

Brbiy Fubs 1

¥ o user's neftwork range s ALL RANGES

B Ehe user & acceEsing content from Windows 10
and the user balangs 1a the graupds) All Users
e 1 Lo May aithenticals uiing Certificats (claud deplayment)

Falback method | Paisword [clowd deploymant)

Falback mathod 2: Password (Lecal Directany)

Fe-authenticate atter 8 hour(s)

Agvanced Prapertes -

network range s ALL RANGES

Af1El T s 16 ACCRERIG Cantant 1am Web Brewser

i “
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14. Select on the Summary tab of the Edit Policy Page.

* You have now enabled Certificate (Cloud Deployment) as an authentication method on

the default access policy.
« Our next step is to ensure this implementation is working.

Part 3: Log into a Windows 10 Desktop and demonstrate

the limitation

Home Share View

.....
- [= New
folder

Organize Ne

Remote Desktops

Enter your credentials

- Mame

These credentials will be used to connect to W10Client01.euc- &4 AppVol.RDP

livefire.com. V%) CaptureVM.RDP

v DEMProfiler.RDP
% Horizon,ROP

5

. . :

euc-livefire\administrator -
| & PackagingVM.RDP

5

q

) RDSHO1a.RDP
% SQLRDP

v [TUEssD,
% W10Client01.RDP

D Remember me P

More choices

& w10Parent01a.RDP
!.':. W51-Connector.RDP

LU 4
12items 1 item selected 2.37KB

OK Cancel

1. On the ControlCenter server Desktop,

* Openthe folder,

+ Select the shortcut

* Log in as EUC-Livefire\administrator, enter the password VMware1!,
+ Select

Installing and Configuring Horizon TRUESSO
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2. On W10Client01 desktop
+ Select > '

Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you,

Open: | R

9 This task will be created with administrative privileges.

Cancel Browse...

jo] Type here to search

[& Consclel - [Console Root]

ﬁ' File Action View Favorites Window Hi

L Mew CrleN
Open... Ctrl+ O
Save Ctri+5
Save As...
Add/Remove Snap-in... Ctrl+M
Optigns...
Recent File
Exit

* Next to Open, type mmc,

+ Select
* In the Console, select

Add or Remove Snap-ins

You can select snapHns for this console from those available an your computer and configure the selected set of snap-ns. For

extensible snap-ns, you can configure which extensions are enabled,

Available snap-ins:
Snap-n
" ActiveX Control
[Eﬂulhonzamn Managsr
b Ce ihates
"-“-Cn'npa"ent Senvices

A Computer Managem...
M Device Manager
" Disk Management
]dli\'rl Wiewer

Falder

Group Pobcy Object ...
B 1P Security Moritar
.g. I Sacurity Policy M....

=] Link o Web Address
£ 3 i

Selected snap-ins:
Vendar A | Console Root

Microsoft Cor...
Microsoft Cor...
Microsaft Cor...
Microseft Cor...
Microsoft Cor...
Microsoft Cor...
Microsaft and..

Add >

Micrasoft Cer..
Micrasoft Cer..
Microsaft Cor...
Microsoft Cor...
Miroseft Cor...
Microsoft Cor...

Desription:

The Certificates snap-n allows you to browse the contents of the certificate stores for yourself, & service, or a computer.

[/ o

Installing and Configuring Horizon TRUESSO
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3. In the Add or Remove Snap-ins window
« Select Certificates,
« Select Add

Certificates snap-in >

Thiz snzp-in will always manage cedtficates for:
(®) My user account

(7) Service account

() Computer account

¢ Back Cancel

4. In the Certificates snap-in, accept the Defaults, select Finish
+ Select OK

i Console! - [Console Root\Centificates - Current User\Personal Certificates]
@ File Action View Favorites  Window  Help
¢ 2P 0/ca= BM
Console Root . Issued To a Issued By

v (¥ Certificates - Cumrent User || §c<n 3¢ A 000BBECAFBIFSADFD...  AirWetchCa
v o Pem:una_1 ?._'demale.striﬂe demalestriten
* Certificates
| Tousted Root Certificatio
| Enterprece Trust
| Intermediate Certificatic
-1 Active Directory User OF
Trusted Publishers

5. Expand Certificates - Current User
* Expand Personal
 Select Certificates
* Note you have an enrolled certificate. If you dont have a certificate, reach out for
support.
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? @l@l Start

« = O @ 2 httpsy/aw-livefirehorizonintm.vidmpreview.com/|

e — | & https://aw-livefirehorizonintrn.vi...
2]

‘ D D https://aw-livefirehorizonintrn.vi...
a5t e L )
£ httpsy//aw-livefirehorizonintrn.vidm...
i
1 )
g‘ My Feed # Personalize - [9 powered by Micre
SOty —_

@a

%X [ hps/asvidmpreviewcomics: X | 4

X |4+ v

vidmpreview.com/cas/t/AW-DEMALE44ARN/API/1.0/REST/landing?EAB_CALLEACK

Select a certificate for authentication

Site casvidmpreview.com:443 needs your credentials:

demale
7 e

demal

KR -

6. On your W10Client01 Desktop
* Open a browser on your windows 10 desktop
* In the address bar enter the URL of your Saas Access Tenant

+ On the Select a certificate window note the account of the certificate
+ Select OK

[ c—EI‘ 2 Favorites | Intelligent Hu I—|— A

R O | hitpsy//aw-livefirehorizonintrn.vidmpreview.com/catale
l'.l Favorites Apps People For You Su
Favorites

Looks like you just moved in.

Add your favorite apps here for quicker aco

. A7
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7. On the Workspace ONE console,

* Select the tab
&| 2 Apps|intelligentHub X | 4+
&« (] o & hitpsy/aw-livefireherizonintm.vidmpreview.com/catalog-pc
r‘ F: ite Al Peopl: For Yc S rt
~ avorites PpRs eople or You uppol
Q Search Apps
New Apps All Apps
New Apps
=
2} \
Tl :
1]} \ N 4
BambooHR Calculator Internet Explorer
N\ A L T . L T
X
Password Request
We need your password to sign in to Calculator.
Password

* Notice we are getting a Password request.

« The 1st reason is, we used a 3rd party Auth method to login to Workspace ONE
Access. (In our session a Certificate based Auth method was used) Workspace ONE
Access did not have the UPN it would have received from a password Auth method, to
pass on to the Horizon Agent.

+ Up to version 1903, Workspace ONE Access would CACHE the credential when a
password method of Authentication was used to login to the Console. Prior to version
20.01 or up to version 1903, when a user logged into Workspace ONE Access with a
password method of authentication, the user would enjoy a Single-Sign on
experience. It was therefore only necessary to Deploy TRUESSO if the users were
authenticating with an Auth method that was NOT password based.

« From version 20.01 Saas onwards, the automatic CACHING of password credentials is
no longer a feature in Workspace ONE Access. This is an enhancement of Workspace
ONE Access security.

* InJune this year a feature was re-introduced to allow Automatic Caching of Passwords
on the Saas Instance of Access

+ We however still need Enroliment services when authenticating with 3rd party auth
methods

* In the next Part, we will proceed with the deployment of TRUESSO to solve this challenge.

+ Select to close the Password Request window.
. and all windows on W10Client01
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Part 4. Installing a sub-ordinate CA and the Enroliment
services

ger =15 N

Add Roles and Features

Remove Roles and Features

Add Servers

Create Server Group

lre ti 1.{_) a_:':_r_']| server Server Manager Properties

1. Onyour ControlCenter server
* Open the Remote Desktop Folder
* Launch TrueSSO.RDP shortcut
*+ Login as Euc-livefire\administrator and enter the password VMware1!
+ On the Server Manager Interface select Manage > Add Roles and Features

s Add Roles and Features Wizard | =1 o .

DESTINATION SERVER

Before you beg N Trues50.euc-livefire.com

This wizard helps you install roles, role services, or features. You determine which roles, role services, ar
features to install based on the computing needs of your organization, such as sharing documents, or
nstallation Typs hasting a website.

Before You Begin

Server Selection )
To remove roles, role services, or features:
Start the Remowe Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* MNetwork settings, such as static IP addresses, are configured

* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard
complete the steps, and then run the wizard again.

To continue, click Next.

] Skip this page by default

Next > nsta Cancel

2. On the Before you begin window
+ Select Next

Installing and Configuring Horizon TRUESSO Export Date: 2023-05-24 07:29:01
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Select installation type , SesTiumon seaven
gafora You Bagin Select the installation fype. You can inctall robes and features on a g physcal computer or wirtual

maching, or on an offfine virtual hard disk (VED)

® Role-based or feature-bated installation
Configure » single sarver by sdding roles, role serices, and features.

_ Remote Desktop Services installation
Install required role senices for Virtual Deskiop Infrastructure (VD) to create a virtual machine-based
of session-bated deskiop deployment.

Server Selection

3. On the Select installation type window,

Ensure the radio button in front of Role-based or feature-based installation is
selected

+ Select Next

: ’ DESTINATION SERVER
Select destination server Y
Bafors You Bagin Sebect & server or a virtual hard disk on which to nstall roles and features.
Installation Typs @ Salect & server from the senver poal
I 5o e
Sarvar Roleg Server Pool
Faaturas
Filter:
Mame IP Address Diperating System

1 Computeris) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager, Offline servers and newly-added senvers from which data
collecton i still incomplete are not shown,

tPtmIl Mext = I [ Inztall E

4. On Select destination server window (accept the defaults)
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+ Select Next

Select server roles

gefore You Begin

Centificate Services?

Add features that are required for Active Directory

o Autharity Mansgement Tools

[ Include mansgerment tocls (# sppbcable)

Selact one or more roles to install on the selected server,

[ Active Directory Domain Services
[ Active Directory Federation Services

[ Active Directory Lightweight Directory Services
[ Active Directory Rights Management Services

Add Festures | | Camcel

Before You Begin

Select one or more roles to install on the selected server,

ctive Directory Certificate Service:

[C] Active Directory Domain Services
[ Active Directory Federation Services

Il Artiee Mirartan: inhtucinht Mirartons Com i ac
+and Access Services
ment Services
3p Services
(= ==

5. On the Select server roles window,
+ Select the check box in front of Active Directory Certificate Services,
* When prompted for the Add Features window, select Add Features box,

* Then select Next

Ea Add Roler and Features Wizard

Select features

Select one o more features 1o irstall on the selected server,

Features

I i
I [ NET Framework 4.7 Features (2 of 7 installed)
I [ Background krtelligent Teansier Senace [BITS)
L] BiLocker Drive Encryption
[ Snlocker Netwadk Unlock
7] BranchCacke
L] Chent for NFS

] Containers

L] Data Center Bridging

L] Direct Play

] Enhanced Storage

L] Falever Clustering

] Group Policy Mensgement

L] Host Guardian Hyper-V Suppon

L] WO Guality of Service

] 15 Hostable Web Core

] Internet Prsting Client

L] P Addeess Management [IPAM) Server
1 ISNS Server senvice

= =] X

SLETNATION FIRVIR
RO e e e g

Diescription

JNET Framipwark 2.5 combones the
power of the NET Framewar 20
AP13 with new technologies for
bulding apphcations that offer
appealing ucer mterface:, protect
your customen’ personal entity
mioernation, enable scamiess and
stoure commurication, and provide
the abdity 1o model & range of
busness prodeites.
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6. On the Select features window

+ Select Next

R
s 5 s - DEETINATION SERVER
Active Directory Certificate Services LT P——
Bafore You Begin Actre Durectony Certificate Sernces (AD C5) provedes the certificate sfrastructure 1o enable soenanos
o : such at secure wirgless networks, virtual private networks, Intermet Protocel Security [IPSec), Network
Installation Type Access Protectson (MAP), encrypting file system (EF5) and smart card log on.
Server Selection )
Sarvar Rolas Things to note:
Faatunes * The name and dormbin settings of thet computer cannot be changed after & certsheation suthorty

(C&) has been installed. i you want to change the computer name, join a domain, or promote this
_ server 1o & domasn controller, complete these changes befors installing the CA. For more
Role Services information, see certification authornity naming.

Confirmation

|¢Pﬂnnul|| Mext > | bretall ||E|

7. On the Active Directory Certificate Services window

+ Select Next

. . DESTIMATICH SERVER
Select role services Trues50 ouc-irwtra com
Bafors You Begn Select the role services 1o install for Active Directory Certificate Services
Installation Type Rele devwicet Description
Sarver Salsction I—m | ertification Authonty (CA) = vsed
M to issue and manage certficates.
f&rw} S [ Certificate Envoliment Policy Web Service Multiple CAz can be Enked b form 5
Faatures [] Cestificate Enwoliment Wek Service public key infrastructure,
ADCS [ Certhcation Authanty Web Enroliment
BN ) etk Do Evobment Sence
Confirmation ] Cnline Responder

I o Previsass I | Bext ™ I Imstall | Cancel

8. On the Select role services window
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+ Select Next

Add Roles and Features Wizard - O] X

P = . . . | P Py - DESTINATEON SERVER
_onfirm installation selections oy

Bafore You Bagin To install the followang roles, role services, or features on selected server, click Install

[« Restart the destination server sutomatically if required

Optional features (such a5 administration tools) might be displayed on this page because they have

- been selected automatically. If you do not want to install these optional features, click Previous to clear
o their check boxes.

cs Add Roles and Features Wizard [ =]

¥ o restart is required, this server restarts automatically, without
B scditionsl notifications. Do you want to allow autematic restarte?

Yes || Mo

sport confguratian settings

Specify an alternate source path

[ <Previous | | next - install | [ Cancel

9. On the Confirm Installation selections window,

+ Select the checkbox next to Restart the destination server automatically if required,
+ On the Add Roles and Features Wizard window select Yes
* Select Install

You will have to wait a short while before moving on to step 10
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DESTINATION SESWVER

Installation progress TruaS80 auc.veten com

View matallateon progress

) Festure installation
. _______________________________________________________|

Configuration required. Installatson succeeded on True5S0Leuc-lvefire.com

the destination

Active Directory Certificate Services Tools
Certification Authority Management Tools

‘fm-{mclmemwwmﬁml-mmmanM?mmmsﬁwm
page sgain by clicking Motifications in the command bar, and then Task Details.

Export configuration settings

10. On the Installation progress page,
+ Select the Configure Active Directory Certificate Services on the destination server

hyper-link

. DESTINATION SERVER
Credentials TrueSS0.euc-livefire.com

IEEEETEE - credentials to configure role services

Role Servaces

To install the following role services you must belong to the local Admanstrators groap:
* Standalone certification authority
= Certification Authority Web Errollment
* Onling Responder

To install the followang role services you must belong to the Enterprse Adming group:
* Enterprise certification authority
* Certificate Enmoliment Policy Web Senvice
* Certificate Enrcliment Web Senice
* Hetwork Device Enroliment Service

Crodentisly: EUC-LIVEFIRE\sdministrator [ chonge— |

Mg about AD 5 Server Rales

[ Prevemus et = Configure

11. On the Credentials window

+ Select Next
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DESTIMATION SERVER

Role Services TrueSS0.euc-livefire.com
Craderiial; Select Role Services to configure
Setup "')'IZ!E E Certification Authority
= Certrhcation Authorty Web Enrallment
CA Type ] Qinline Responger
Privaie Kay | Metwork Device Enroliment Service
Cryptographny Certificate Enroliment Web Senvice
Ca Mame Certifcate pnrollment Poloy Web henace

Ceriificate Regues
Certificate Database
Confirrmation

More about A0 C5 Server Robes

|_ « Pressout ] | MNext = Confugure

12. On the Role Services page,
+ Select the Certificate Authority checkbox
+ Select Next

DESTINATION SERVER
Setup Type TrueSS0.cuc-livefire.com
Crederials Specify the setup type of the CA
Role Services

Enterprce certification authorties (Chsg) can use Active Directory Doman Senaces (AD DS) to
simplify the management of certihcates. Standalone Chs do not use AD DS to issue or manage

CA Type certificates.
Private Key =

- N ) Emterprse CA

ryptogragny Enterprize CAz must be domain members and are typically enline to izsue certificates or
CA MName certshicate policies.
rificate Reques: -

Certificate Regues O st .
Certificate Database Standalons CAs can be members or & workgroup or domain. Standalons Cas do not require 40
Confirmasion DS and can be used wathout & network connection (offline).

More about Setup Type

[ < Previous | | Next> | Configure

13. On the Specify the setup type of the CA window ,
+ Select the radio button next to Enterprise CA
+ Select Next

Installing and Configuring Horizon TRUESSO Export Date: 2023-05-24 07:29:01
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CA Type

Credentials
Role Services
Setup Type
L canee |

Private Key

Crypiography

CA Mame

Certificate Reguest
Certificate Database
Confirmason

DESTIMATION SERVER
TrueS50.euc-livefire.com

Specify the type of the CA

When you install Active Directory Certificate Senvices (A0 C5), you are creating or extending a
public key infrastructune (FEI) hierarchy. & root CA is at the top of the PKI hierarchy and issues its
own self-zagned certificate. A subordinate CA recerves a certificate from the CA above it in the PKI
higrarchy.

O Root CA
Root CAc are the first and may be the only CAc configured in a PK] hierarchy.

(®) Subordingte CA

Subordinate CAs reguire an sstablished P hierarchy and are authorized to issue certificates by
the C& above ther in the heerarchy.

Mare about CA Type

-:Plninmll Next = | _{mhguue_

14. On the CA type window
+ Ensure the Subordinate CA radio button is selected,

+ Select Next

Private Key

Crederntials
Rele Services
Setup Type
CA Type
XTI
Cryptegraghy
CA Name
Certificate Reguest
Ceriificate Database
Confirmation

DESTINATION SERVER
TrueS50.cuc-livefire.com

Specify the type of the private key

To generate and issue certificates to clients, a certification authorty (CA) must have a private key.

®) Create & new private key
Uze thiz option if you do not have a private key or want to create a new private key.

) Use existing private key
Use tha option to enture contmiuity with previously msued certificates when reinstalling a CA

Select a certificate and use ils associated private key
Select this option i you have an exsting certificate on this computer or i you want to
import a certrficate and use its associated private key.
Select an existing private key on this computer
Select thiz aption i you have retained private keys from a previous nstallation or want to
uze 8 private key from an altemate source.

More about Private Key

] ] [ convow | [T

15. On the Private Key window,
+ Ensure the radio button next to Create a new private key is selected
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+ Select Next

Cryptography for CA

DESTINATION SERVER
True550.euc-livefire.com

Carfirrmaten

More absout Cryplography

(oo ] e |

Credentials Specify the cryptographic options
Riobe Services
Setup Type Select a cryptographic providen Key bength:
CA Type Setup Type FMicrosoft Software Key Storage Provider [=][ 2044 [~]
Private Key Select the hach algorithm for signing certificates issued by this Ci:
| crpiooaeny [ -

CA Mame SHA3EL I:

Cermificate Reguest 5HA512 —
Certificate Database SHA1

BATYS =

] Alicw administrator interaction when the private key is accessed by the Ca

Configure Cancel I

16. On the Cryptography for CA window select the following

+ Under Cryptographic Provider: RSA#Microsoft Software Key Storage Provider

+ Next to Key Length: 2048
+ Hash Algorithm: SHA256

+ Select Next
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DESTINATION SERVER

CA Name TrueSS0euc-livelire.com
Credentials Specify the name of the CA
Role Services
Setup Type Type a common name to santify this certification authority (CA). This name is added to all
I certificates issued by the CA Destinguished name suffic values are automatically generated but can
CA T be modified.
Private Key
crye aph Common name for this CA:
¥El Y
— euc-livefire-TRUESSD-CA
Certificate Request Distinguished nanve suffioc
Certificate Database DC = eue-tnnefire DC=com
Confirmation

Preview of distinguished name:
CH=euc-lrsefire-TRUESSO-CA DC = puc-levefre, DC =com

More about CA Name

| <Previous || Meas | .{Znnﬁqurr_E

17. Onthe Specify the Name of the CA window

* Observe the CA naming convention
+ Select Next

s 4D €5 Configuration
i DESTINATION SERVER
| Certificate Request TRUESSO.euc frvefire.com
Cregental Request a certificate from parent CA
Role Servces
Sep Type Vou require a centificate from a parent ion suthority [CA) to allow this Cato
| . il isSUe Certficates. You Can request 3 Certficate from an online CA OF yOU CBR STOME YOUr FEqQUEst 10
<A Type & file 10 submit to the parent CA.
| Private Kay
@ Send a certificate request to a parent CA:
Cryprography s
CA Name (@ CA name
O Computer name
Select Certfication Authority T [ Select
Select a cersficaton authortty (C4) you want to use.
ca Computer
< >
[
. e Nest Configure | [ Camest |

DESTINATION SERVER
Certificate Request TrueS30.euc-Iovefie com
Credentials Request a certificate from parent CA
Roie Servees
Setup Type Vou require a certficate from a panent certification authasity (CA) ta alkaw this subordinate CA ta
. st certates. Vou £an FeauESt B CRPBREAE from i Gnliet (i) 61 Yo €A1 $15TE your reqUES 18
CA Type a file to submit to the parent CA.
Private Key
N ® Send 3 cenificate request 1 & parent CA:
Select:
® CArame
©) Computer name
- : oaoncovren [
© Sawe & contificate raquest to file o the target machine:
File name: CA\TrueSS0.eue-ivefire.com_euc-iefire- TRUESSO-CAreq
A Vo must manusly get a certficste back from the parent CA to make thes CA operstional.
More about Certficate Request
s e |
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18. On the Request a certificate from parent CA,
+ Select the radio button next to Send a certificate request to a parent CA:
+ To the right of the Parent CA box, click the Select button
+ Select OK accept the Default
+ Select Next

- ALY D T Un LT

| Ml M|
- - DESTINATION SERVER
i T [p——
I !_.',_‘. didse TrueS50.euc-livefire.com
Crecleriiale 5|:‘:: fy the database locations
Role Servises
Letup Tyoe Certificate database location
CA Type C\Wmndowt\aystemd\Lerlog
FrEE e Certificate database log location:
wFyFRgrapn CAWmdows\systemI N Cerlog
CA Mame

¢ ak CA Dakal <
« Pravious Next » ' Cancel
19. On the CA Database window,
« Select Next
Installing and Configuring Horizon TRUESSO Export Date: 2023-05-24 07:29:01
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DESTINATION SERVER

Confirmation TrueS50.euc-livefire.com
Credentials Tor configure the following roles, role senices, or features, chek Configure.
Role Services # Active Directory Certificate Services
Setup Type "
Certification Authority
CAT
T CAType: Enterprise Subordinate
Private Kﬂ Cr,pm-gnph'u: providen REAarblicrosoft Software mimmgl Prosader
Cryprography Hpsh Algarithm: SHASE
Ca MName Key Length: 2048
Certficate Roques Allow Administrator Interaction: Disabled
) Certibicate Vahdity Perod: Dietermined by the parent CA
tific .
SIURCHE BEEIe Distinguished Name: CHeeuc-lvefire-TRUESSO-CA, DC = euc - lvefire, S scom
Onlme Parent CA Information: Controlcenter2.euc -Ivefire.comguc-Ineefire-CONTROLCENTER2 -
Ci
Certificate Database Locatiore  CAWiIndows\system32\Certllog
Certificate Database Log CAWIndows\system3ZCertlog
Loscation:

[[<Previous | | reem - [ Contigure | [ cCamcer |

20. On the Confirmation window
+ Select Configure

DESTINATION SERVER
Results TriesS0.eu-Hivefiee.com
The faliowing roles, rale srvices, or festunes were configuned:
~ Active Disectary Certificate Services.
Certification Autharity @ Configuration sucesded

Mare about CA Confguration

T = e
sttt it A ————— |

HATION SEVER

Installation progress Tecedi v o

Vet installation pregress

@ Feoture installation

Combiguration required. batsllation sutceeded on TrueSS0Leus lvefire.com.

Certificate Services
Al Aetive Direstary C ity reie senees the destinati
Certification Authority
Reenate Serves Administration Tock:

21. On the Results window
+ Select Close
+ On the Installation progress window,

Installing and Configuring Horizon TRUESSO Export Date: 2023-05-24 07:29:01 Page 31
-0600



+ Select Close

Part 5: Deploying and Configuring Horizon TRUE SSO

Add or Remove 5

Tou can select oo for tis cungole from those avalobie on your come
‘extenchis cnap-r, ‘which extoncon: are enabled.

1. In this section we will create a certificate template for Horizon TRUE SSO
* On your TRUESSO server select Start > Run > type mmc
Select File > Add/Remove Snap-in...
Select the Certificate Authority services snap-in, select Add
In the Certificate Authority window,
+ Select the Local computer radio button
+ Select Finish

Select OK to close the Snap-ins window
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B File Action View Favorites Window Help

e @ = H=

| Console Root
4 L5 Certification Authority (Local)
4 g5 euc-livefire-TRUESSO-CA

| Revoked Certificates
2 Issued Certificates
[l Pending Requests
[ Failed Requests

[ Certificate Termnlates

Manage P

Mew 3

MNew Window from Here
Refrech

Help

2. Expand the euc-livefire-TRUESSO-CA
« Select Certificate Templates,
* right-click and select Manage

2 Certificate Templates Console
File Action View Help

oo | mlc= HMm

inventory

# Certificate Templates (Controlce

Template Display Ma me

& Key Recovery Agent

& NS

15 OCSP Response Signing

{5 RAS and IAS Server

13 Root Certification Authority

15| Smartcard Logon

#) Subordinate Certification Authority
32 Trust List Signing

3 User

35 User Signature Only

& VMware Certificate

& VMware-SSL

uE] Web Server

2% Workstation Authentication

<

Schem #

Pd = P P =k =k =k b =k = = = P W PO P

3. In the Certificate Template Console

* Find and select the Smartcard Logon template
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) Certificate Templates Console

File Action View Help

e |m D= HMm

3 Certificate Templates (Controlce Template Display Name Sct

1] Key Recovery Agent

1G] NSX

15 OCSP Response Signing
15 RAS and IAS Server

13 Root Certification Authority

| :]

U Properties

Help
-’E VIUI“GI‘C el ivaLle

& VMware-55L
@ Web Server
@ Workstation Authentication

£ 21 £

4. Right-click the Smartcard Logon template
+ Select Duplicate Template

| Suectbame |  Sower | lemsanco Requimmonts
| Superseded Tomplstes | Extensons Secaly
The template options avaiable are based on the earbost operating system
versions s&l in Compatibity Settings
[ Show resuting changes

Compatibilty Settings
Cenfication Aushonty
Windows Server 2012 R2 v

Centficate recpent

Windows 8.1/ Windows Server 2012R; v |

These seltings may not prevent codicr operating systems from uaing this
template

5. In the Properties of New Template window in the Compatibility tab under Certificate
Authority

+ Change from Windows 2003 to Windows 2012 R2
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* When prompted for the Resulting changes window
+ Select

+ Under Certificate recipient change Windows XP / Server 2003 to

* When prompted for the Resulting changes window
+ Select

Properties of New Template -

Subject Name | Server | Issuance Reguirements
Superseded Templates | BExdensions | Securty
Compatiilty | General | Request Handing | Cryptography | Key Attestation

Template display name:
[Trues50 Template

Template name:
TrueSSOTemplate

Validity period: Renewal period:

1| | hours v | 0f {houra v

[T Publish cerfficate in Active Directory

not automatically reenroll f a duplicate cedificate edsts in Active
rectony

Certificate Templates -

The renewal period (6 weeks) is larger than the maximum allowed. To
automatically set the renewal period to the maximum allowed (0 hours), click OK.
Te change the renewal or validity pericd to a different value, click Cancel,

oK | Cancel

6. Select the tab,
* Under Template display name: type TrueSSO Template, you will notice Template name
gets filled in automatically.
* (Don't edit the TemplateName)

+ Under Validity period change the period from 1 years to
+ When prompted by the Certificate Templates Box
+ Select
+ The Renewal period will automatically change from 6 weeks to 0 hours
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7. Select the
« Purpose: change: Signature and encryption to
+ When prompted, select

Installing and Configuring Horizon TRUESSO

-0600

Select the
Select the

Properties of Mew Template X

Subject Name Server Issuance Requirements
Superseded Templates Extensions Security
Compatibilty General Request Handing  Cryptography = Key Attestation

Purpose: Signature and smartcard logon ~

Delet

voked or expired certficates {do not archive)

ymmetric algorithms allowed he subject

Archive subject’s encryption private key

Allow private key to be exported

[ Renew with the same key

For automatic renewal of smart cand certificates, use the existing key if a
new key cannot be created

Do the following when the subject is enrclled and when the private key
associated with this certificate is used:

Enroll subject without requiring any user input
(®) Prompt the user during enroliment

O Prompt the user during enrollment and require user input when the
private key is used

ox Wy | [ v

tab change the following next to :-

in front of Allow private key to be exported
in front of For automatic renewal of smartcard certificates, use

the existing key if a new key cannot be created

Select the

in front of Prompt the user during enrollment

Export Date: 2023-05-24 07:29:01
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Subpect Naene | Server | I Requeements
Superseded Templates | Extensions Securty
Compstbilty | Genersl | Request Handing | Coblograohy | Key Attestation
Provider Calogery: | Kay Stormge Provider w|
AMgothm rame: |Rsa -

oy

Chooss which cryptographs: providers can ba used for reguests.
(®) Raguests can use any provider avaliable on the subject’s compuler
) Reguests must use one of the following providens:

Provides | WhersThist

[CIMecrosclt Scltware Key Storage Provider

Reguest hash: SHAZSE u]
[ Use atemats signaturs format
| ok || Canest || ooy || B |

8. Select the Cryptography tab change the following next to
+ Provider Category: Key Storage Provider
* Minimum key size: 2048
* Request hash: SHA256

9. Select the Server tab,

Compatbity | General | Request Handing | Cryptography | Key Attestation
Supesseded Temmlstes | [T | Secudy
Subject Nome Server | lssusnce Requicments

[+ D et store conficaten and requests n the CA detshase

[[] Do nist include rrvocation inf in issued contfi
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+ Select the in front of Do not store certificates and requests in the CA
database
+ You will notice that Do not include revocation information in issued certificates is
selected automatically.

* Uncheck the next to Do not include revocation information in issued
certificates

TrueSS0 Termplate Properties 7 k4

General Compatibilty Reguest Handling Cryptography  Key Afiestation
Supersded Templstes Estansionz Securty Saerver
Subject Name lzsuance Reguirements

Require the following for enroliment

[ CA cerificats manager aporoval

] This numbes of authorized signatures: 1

I you require mone than ane sgnature, sutoenmliment = not alowed

Polcy type required in signature:;

Application policy i
Applcation palicy;
Certficate Request Agent -

Require the following for reenraliment:
f.'_-:' Same criteria as for enmliment
(®) Valid eisting certficate

Requires subject information lo be provided within the cerdificates
request

* Control is disabled due to compatibiliy seftings

oK Aeply Help

10. Select the tab, configure the following:
+ Select the : This number of authorized signatures and change the value to 1
in the box

+ Under Policy type required in signature
+ Ensure the Application policy is selected (default config)

« Under Application Policy
+ Select from the dropdown

+ Under the Require the following for reenrollment
+ Select the Valid existing certificate
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Group or user names:

& Administrator (administrator@eucivefire.com)
82 Domain Admins (EUC-LIVEFIRE\Domain Admins)
S8 Enterprise Admins (EUC-LIVEFIRE\Enterprise Admins)

Add... | Remove

D, TR frr L dhartinstad |lears Al
Select Users, Computers, Service Accounts, or Groups X

Users, Groups, or Builtin security prncipals
From this location:
| Frmr——— 1

Object Types

[ Object Types...

Select the types of objects you want to find.

[k ]/ cancu

11. On the Security tab in the Group or user names: area
+ Select Add

+ To the right of the Select this object type: box
+ Select the Object types button

+ Select the checkbox next to Computers,
+ Select OK

Select Users, Computers, Service Accounts, or Groups X |

Select this object type:
|Lhers_l:'o-mq.tm,ﬁm,ar&n1tm securty principals | ' Object Types...
From this location: '

Enter the object names to select (examples):
TRUESS0

.D'leckNarn&a

12. In the Enter the object names to select
+ Type Truesso
* To the right select Check Names
+ Select OK

Installing and Configuring Horizon TRUESSO Export Date: 2023-05-24 07:29:01
-0600

Page 39



TrueSSO Template Properties ? X

General Compatibiity Reguest Handling Cryptography  Key Attestation
Subject Name lssuance Requirements
Superseded Templates Edensions Security Server

Group or user names:
82 suthenticated Users
2 Administrator (administrator@euc-ivefire com)
S2 Domain Admins (EUC-LIVEFIRE\Domain Admins)
E2 Enteprise Admins (EUC-LIVEFIRE\Enterprise Admins)
! TRUESSO (EUC-LIVEFIRENTRUESSOS)

Pemissions for TRUESSO
Full Conttrol
Read
Wite
Envol
Autoenmol

For special pemissions or advanced settings., click
v L Advanced

oK Aoy Help

13. For the Permissions for TRUESSO
+ Ensure that the permission Read and Enroll checkboxes are selected.
+ Select OK to close the TrueSSO Template Properties,

;J certsrv - [Certification Autherity (Local)\euc-livefire- CONTROLCENTER2-CAN\Certificate Templates)
File Action View Help
s 7|6z H
L Certification Authority (Local) Name I
v g euc;w;ZEON:ﬁOLCENTERZ-Cﬁ ) EUCSE-user al
| Tevo f‘?‘ rcates ] Directory Email Replication Di
| Issued Certificates - ) _
. 5 Domain Controller Authentication Cl
| Pending Requests - _
2 e 4 Kerberos Authentication Cl
| Failed Requests 3 )
3 Certificate Temolates = EFSlRecuver)' Agent Fil
Manage *1] Basic EFS Er
i8] Dioaiin Conteoller Cl
New > Certificate Template to lssue Se
View y E Computer cl
F User Er
Refresh E Subordinate Certification Authority <
Export List... H Administrator M
Help
<

14. Switch to the Certificate Authority Console
+ Select and right-click the Certificate Templates container,
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« Select New > Certificate Template to Issue

B ' Enable Certificate Templates

Salect one Cedificate Template to enable on this Cerffication Authority.
Note: K a certfficate template that was recently created does not appear on this list, you may need to watt until
irformation about this template has been replicated to all domain controllers.

All of the cedificate templates in the organization may not be available to your CA.
For more information, see Certificate Template Concepts,

Mame

F RAS and IAS Server
5] Router (Offine request)
EﬁnﬂtcadLngu'l
7 Smartcand User
_FJ-ESE-{}TF..!TDIETE
| Trust List Signing
] User Signature Only

T VWware Cenfficate

5] VMware-5SL

5] Workstation Authentication

Intended Purmpose

Client Authentication, Server Authentication

Client Authentication

Client Authentication, Smart Card Logon

Secure Email, Client Authentication, Smart Card Logon

Smart Card Logon, Client Authentication
Microsoft Trust List Signing

Secure Email, Client Authentication

Server Authentication, Client Authentication
Server Authentication, Client Authentication
Client Authentication

Cancel

15. In the Enable Certificate Templates window,

* Select your TrueSSO Template
+ Select OK

F Certificate Templates Console
View

I Mo iEREYE 7 Mo:

File Action Help

3] Certificate Templates (Controlce

Template Display Namﬂe

5 Directory Email Replication

12 Domain Controller

+4] Domain Controller Authentication
4 EFS Recovery Agent

& Enrellment Agent

F] Enrollment Agent (Computer)
i Exchange Enr
& Exchange Sigi
& Exchange Use
1] IPSec

2 IPSec (Offline

JE Kerberos Auth
M. = : ) -

— o pa — g

it

Duplicate Termplate

All Tasks b

Properties
Help

Schema Version

16. Switch back to the Certificate Templates Console select and right-click the Enroliment
Agent (computer) template and select Properties
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Enrollment Agent (Computer) Properties

General Request Handling  Subject Name E:den

play name:

Enroliment Agent (Computer)
Minimum Supported CAs:  Windows 2000

T amolate name:

Machine Enmoliment Agent

Validity period: Renewal period:

2,&3‘3 s 6 |weeks B

Publizh certfficate in Active Directory

Do not automatically reenroll if & duplicate certificate exdsts in Active
Directory

ok [ Concel || mply | Hebp |

17. In the Enroliment Agent Properties window
+ Select the Security tab

| General | Request Handing | Subject Name | Extensions | Securty
Group or user namas
B Aushenticated Users
B2 Domain Admins (EUC-LIVEFIRE\Domain Admins)
82 Erterpase Admins (EUC-LIVEFIRE\Enterpnse Admins)
B TRUESSO (EUC-LIVEFIRE\TRUESSOS)

[ Add. || Remove |
Permissions for TRUESS0 Allow Deny
Full Control a O
Read [+ O
Wrie [._| O
Ervol v O

For special permissions or advanced settings. chck
Advanrced

[ ok || canc || seay | oo

18. Select Add and add the TRUESSO Computer account with Read and Enroll permissions .
+ Select OK to close the Enrollment agent properties
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j:,J certsrv - [Certification Authority (Local)\euc-livefire- CONTROLCENTER2-CA\Certificate Templates)

File Action View Help

s 7| 0= H

L Certification Authority (Local)

v gi euc-livefire-CONTROLCENTER2-CA
| Revoked Certificates
7 Issued Certificates
~| Pending Requests
~| Failed Requests
~ Certificate Temoplates
Manage

New »
View >

Refresh
Export List..

Help

Narme

& EUCSE-user

& Directory Email Replication

7] Domain Controller Authentication
] Kerberos Authentication

HEFs Recovery Agent

) Basic EFS

Tl Namain Cantroller

Certificate Template to Issue

E Computer

] User

l Subordinate Certification Authority
E Administrator

Cl
Di
Ci
Cl
Fil
Er
Cl
Se
cl
Er

[ SO TR S VR RO NN TS— T .

19. Switch back to the Certificate Authority Console select

+ Right-click the Certificate Templates container,
+ Select New > Certificate Template to Issue

B ' Enable Certificate Templates

Salect one Cerificate Template to enable on this Cerffication Authority.

MNote: F a certificate template that was recently created does not appear on this list, you may need to wait until

information about this template has been replicated to all domain controllers.
Al of the certficate templates in the organization may not be available to your CA,

For more information, see Cedificate Template Concepts,

Mame

7 Aghenticated Session

| CA Exchange

| CEP Encryption

5 Code Signing

F Cross Certfication Authorty
7] Ermolment Agent

9] Envoliment Agent (Computer)

%] Exchange Enroliment Agent (Dffline request)

5] Exchange Signature Only
EEICI‘IEI‘QEUSH’

o .

Intended Fumpose

Client Authentication
Private Key Archival
Cerfficate Request Agent
Code Signing

<Al

Cefficate Request Agent

Certificate Request Agent
Cerificate Request Agent
Secure Email
Secure Email

20. Inthe Enable Certificate Templates window
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+ Select the
+ Select

template

Metwork Connections

Disk Management

Computer Management
Command Prompt

Command Prompt (Admin})

Task Manager
Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

21. We will now configure the CA for non-persistent certificate processing

¢ On the TrueSSO server

+ Select and right-click the

+ Select

Installing and Configuring Horizon TRUESSO
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B Administrator: Command Prompt -

22. In the Administrator: Command Prompt enter the following commands

* certutil -setreg DBFlags +DBFLAGS ENABLEVOLATILEREQUESTS

23. Configure CA to ignore offline CRL errors
* certutil -setreg ca\CRLFlags +CRLF REVCHECK IGNORE OFFLINE
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net start certsvc

24, Restart the CA service. From the command prompt run:
net stop certsvc

¥ CQuick access
Bl Decktop
& Downloads

Z| Documents
| Pictures

B This PC

¥ Metwork

25. On the TrueSSO server desktop
Launch the
* In the Software folder, open the
Select and launch the

Installing and Configuring Horizon TRUESSO

honzon.euc-livefire.com

i) HorizenRecordingfgent-1.1.
i) HorizonRecordingServer-1.1
ViMware-horizonagent- linum-

_._'j VMware-Hornzon-Agent-x86_

f'_.')! Aszsist For Horizon-Win10-21.11.00,112

ob

D2
x86_64-2111.1-8.4.0-19066680.tar.gz

64-2111.1-8.4.0- 19066669

Mware-Honzon- Connection-5Server-xB6_64-8.4.0- 1906783

: ViMware-Honzon-Extras-Bundle-2111-8.4.0-18958069

folder.
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Open File - Security Warning x

We can’t verify who created this file. Are you sure you want to run this file?

T Mame: .. Horizon-Connection-5erver-xB6_64-8.4.0-19067837. exe
— Type: Apphcation
From: ‘\\honzon.euc=livefire.com\software\Honzon'21114\WM...

Run . Cancel

: This file is in a location outside your local network. Files from locations
'@ you don't recognize can harm your PC. Only run this file if you trust
the location. What's the risk?

26. On the Open File - Security Warning window
+ Select Run

#¥ VWhware Horizon Connection Server X

Welcome to the Installation Wizard for
VMware Horizon Connection Server

The nstallation wizard will install VMware Horizon Connecbion
Server on your computer. To continue, chick Next,

Copyright (c) 1998-2021 VMware, Inc. All ights reserved. This
product is protected by U5, and international copyright and

VMware intelectual property laws. VMware products are covered by
: ; one or more patents ksted at
H ori Z O n hittp: [, vimware. com fgo fpatents.
Product version: 2111 < Back Cancel
27. On the Welcome window
+ Select Next
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# Vitware Horizon Connection Server

License Agreement
Pleace read the followang license agresment carefully.

Last updated: 03 May 2021

(®) [ accept the terms in the license agreement
()1 do not accept the terms in the license agreement

VMWARE END USER LICENSE AGREEMENT

THE TERMS OF THIS END USER LICENSE AGREEMENT (“EULA™)
GOVERN YOUR USE OF THE SOFTWARE, REGARDLESS OF ANY TERMS ~

oo o> ]| cance

28. Onthe License agreement window

+ Select the radio button next I accept the terms in the license agreement,

+ Select Next

#¥ VMware Horizon Connection Server
Destination Folder

g _j Instal VMware Horizon Connection Server to:
C:Program Files\VMware \¥Mware View\Server),

< Badk

Chck Mext to install to this folder, or ceck Change to install to a different

29. On Destination Folder window
+ Select Next
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' Vilware Horizon Connection Server x

Installation Options
Selact the type of Horizon Connection Server instance you want to ins

Select the type of Horizon Connection Server ingtance you want to instal,

on Standard Server

Perform an Enroliment Server instance install. This is used for True SSO.
Ervoliment Server only uses [Pv4 protoool for establishing all connections.

This server will be configured for a Horizon environment.

T e

30. On the Installation Options window select Horizon Enrollment Server
+ Select Next

' VMware Horizon Connection Server *

Firewall Configuration
Automatically configure the Windows Firewall to allow incoming TCP prof
cormechons.

In order for Horizon Enroliment Server to operate on a network, spedific incoming TCP port
must be allowed through the local Windows Firewal service, The incoming TCP port is
32111 (view Framework channel).

(®) Configure Windows Frewall automatically
() Do not configure Windows Firewall

< Badck Mext = Canced

31. On Firewall configuration window
+ Select Next
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#¥ vMware Horizon Connection Server

Ready to Install the Program
The wazard is ready to begin installabon.

Vihware Horizon Connection Server will be installed in:
C:Wrogram Fles\WWware \ViMware View\Server),

Oick Install to begin the installation or Cancel to exit the wizard.

<Back || mnstal || Cancel

32. Select Install

#F VWhware Horizon Connection Server =

Installer Completed

The installer has successfully installed YiMware Horlzon
Connection Server. Chck Finish to ext the wizard.

Next Steps:
[ Show the documentation
VMware
Horizonr
Product version: 2111 < Back Cancel

33. On the Installer Completed Window
+ Select Finish
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Programs and Features

q Power Opticns

Event Viewer

System

Device Manager
Network Connections
Disk Management

Computer Management
Command Prompt

Command Prompt (Admin)

Task Manager

Contraol Panel

File Explorer

own or sign out

Desktop
hm a i.

Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

Open: w

'@ This task will be created with administrative privileges.

=]

[ ok ][ cance |[ Browse. |

34. Onthe TrueSSO server

+ Select and right-click the Start Button,
+ Select Run,

+ Type MMC,

+ Select OK

| 4 [ =1 uem
a Consolel - [Console Root)
File Action View Favorites Window Help

45 MNew Ctrl+M
A=  Open. ce0
Save Ctrl+5

Options...

1 C\Windows\...\dnsmgmt.msc

2 C\Windows\system32\dsa.msc
3 C\Windowsh...\certsrv.msc

4 C\Windows\...\compmgmt.msc

Exit
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35. In the Console window

* Select File > Add/Remove Snap-in..

Add or Remove Snap-ins

You can sslect snap-ns for this corsole from those avaiable on your computer and configure the selected sat of sap-ins. For
extensble snap-ns, you can configure which extensions are enabled,

Available sap-ns:
Snap-n
s Active Drectory Do
A% Brtive Directary Sch....

WIS Active Directary Site...
— Active Directory Use...

= dectiveX Cantral
& B0S1 Edit
Autharization Manager
! Certfficate Templates
€ Certcot: |
Lalcertification Autharity
:"-C-ommr-:ﬂtSmI:l:ﬁ
= Compuiter Manages, .,
P cevice Manager

Descrphon:

\iendar “
Mirosoft Cor...
Microsoft Cor...
Microsoift Cor...
Microsoft Cor...
Micresoft Cor...
Murpsoft Cor...
Microsoft Cor...
Microsoift Cor...
Microsoft Cor...
Microsoft Cor...
Mucrosoft Cor...
Micresaft Cor. ..
Mucrosoft Cor...

W

Add >

Selected snap-ns:
I Conasle Root Edit Extengions. ..
Lemove
Mowe Lig
Mowe Down

The Certificates snap-n allows you o browse the contents of the cerbrficate stores for yourself, a service, or a computer.

[oc ][ con

36. Inthe Add or Remove Snap-ins window,

+ Select Certificates
« Select Add

Cetificates snap-in

This snap-n wil always manage cettficates for:

O My user account
O Service account
(® Computer account
<Back Cancel
Select Computer X

Select the computer you want this snap-in to manage.

This snap-n wil always manage:

@andnmp\.te- {the computer this console is running on)

(O Another computer:

[ Allow the selected computer to be changed when launching from the command line. This
console

only applies  you save the

Browse..

37. Select Computer account radio button
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+ Select Next
+ Select Finish
+ Select OK

ﬁ File Action View Favorites Window Help

Y EEIEEN

7] Conscle Root lssued To * Issued By
4 @ Certificates (Local C ‘Eeuc-liveﬁre-THUESSO-Cﬂ euc-livefire-COMTROLCEMTERZ-...
4 || Personal

[ Cert= —
b [ Trusted | All Tasks J Request New Certificate...
r Enterpri View 3

¢ -] Smart Card Trus
i -] Trusted Devices
¢ o VMware Horizor
¢ o VMware Horizor

b [ Interme Mew Window from Here Advanced Operations 3
- || Trusted

B ] Untrust Mew Taskpad View...

B[] Third-P Refresh

= TrTJStEd Export List...

p o] Client A

b [°] Rernote Help

Expira
11/3/¢

38. Expand the Certificates console inventory
+ Select and right-click the Personal container.
 Select All Tasks > Request New Certificate
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Ll Certificate Enroliment
|

Before You Begin

The following steps will help you install certificates, which are digital credentials used to connect to wireless
networks, protect content, establish identity, and do other security-related tasks.

Before requesting a certificate, verify the following:

Your computer is connected to the network
You have credentials that can be used to venfy your right to obtain the certificate

Cancel

39. On the Certificate Enrollment > Before you Begin window
+ Select Next

@l Certificate Enroliment

Select Certificate Enrollment Policy

Certificate enrollment policy enables enrollment for certificates based on predefined certificate templates.
Certificate enrollment policy may already be configured for you.

Configured by your administrator
Active Directory Enroliment Policy

Configured by you Add Mew

40. On the Select Certificate Enroliment Policy window
+ Select Next
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5] Certificate Enroliment

Request Certificates -
ns 3
You can request the following types of certificates. Select the certificates you want to request, and then
click Enroll.
Active Directory Enrollment Policy
[ Computer i) STATUS: Available Details +
B4 Enroliment Agent (Computer) 1) STATUS: Available Details v

] Show all templates

41. On the Request Certificates windows
+ Select the checkbox in front of Enrollment Agent (Computer)
+ Select Enroll

Certificate Installation Results

The telicwnag rertthestes muvs b earsled and indtalled an the corpite

Acthve Lirectory Laroliment Polcy
< [mmliment Agent (Campurter) o STATUS: Gireesces Dl

42. On the Certificate Installation Results window,
+ Ensure the enrollment was successful
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+ Select

= | ChUsers\Administrator,Desktop'\Remote De

-

“«r X~
_I Whass = | ¥
to Quick Copy Paste = -1- Mew
Le folder
desktop.ini Clipboard Organize Mew
i k » Remote Desktops v
d Mame
7 Quick access .
w4 AppVel RDP
simulations B Deskto -
rmuistien g &, CaptureVM.RDP
¥ Downloads %, DEMProfiler.RDP
: =| Documents -~ Horizon.RDP
&=/ Pictures & PackagingVM.RDP
Recycle Bin hol % RDSHO1a.RDP
Remote Desktop ‘_ SOLRDP
T B TrueSSO.RDP

43. Switch to your ControlCenter server,
+ Open up your folder and to
« With username euc-livefire\administrator and password VMware1!

& Horizon - horizon.euc-livefire.com - Remote Desktop Connection

44. On the Horizon Server desktop
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+ Select and open your Cert Console.mmc

i File Action View Favorites Window Help
oo 2@ o o= B

1 Console Root Issued To

4 () Certificates (Local Computer) ¥ o147815b94-9¢ c2-4fd0-a7F:
4 [ Personal Tylbroker/cs1-pd1

' | Certificates ol broker/cs1-pd1

| Trusted Root Certification Authorities Tl router/cs1-pd1

Enterprise Trust - N Tl router/cs1-pd1
| Intermediate Certification Authorities Tpltunnel/cs1-pd1

| Trusted Publishers @ )

| Untrusted Certificates “altunnel/cs1-pd1
Third-Party Root Certification Authorities
Trusted Pecple

Client Authentication lssuers

Remote Desktop

Certificate Enrollment Requests

Smart Card Trusted Roots

Trusted Devices

e

F LS LS LS LE LS

L

T T T T T T T T T YT W

| VMware Horizon View Certificates

| Certificates

45. In the Certificates Console
+ Expand the inventory
* Browse down to VMware Horizon View Certificates > Certificates

Favwines BRI Lal-l o

[ (| H|m
lsouedTo = o JiuedBy  ExpirationDate | Intended Purpo
Gpl47815604-9cc2-4d0-a7f5-30dc... 47815604 Scc2-fd0.. 1011/2030 <Al
Tlbroker/cs1-pd1 broker/cs1-pd1 1/3/2021 <All=
|| Talbrokerfcs1-pd1 broker/cs1-pd1 61272020 <All= CennectionBroker
: Tl router/cs1-pd1 router/cs1-pdi 61272020 <All= MORouter
| Tl router/cs1-pd1 router/cs1-pd1 1/3/2021 <Al MORouter
Eltunnelfcs1-pd1 tunnel/cs1-pd1 1/3/2021 <All= Tunnel
I Fltunnelfcs1-pd1 tunnel/cs1-pdl 671272020 < All> Tunnel

46. In the VMware Horizon View Certificates > Certificates folder
+ Expand the console or scroll across the console and notice the guid based certificate has
a friendly name of vdm.ec
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&, C51-pd1 - cs1-pdl.euc-livefire.com - Remote Desktop Connection

& File Action View Favorites Window Help

e nE £ & XD

] Certificate Enrc
1 Smart Card Tru

] Console Root lssued To - Issued By Expirat
4 () Certificates (Local || BRiERAET TP MR 47815004-0cc2-4d0...
4 (1] Personal . broker/cs1-pd1
| Certificates ﬁlbm’| All Tasks > | Open 6/12/2
b [ Trusted Root C|| ] router/ —— - 6/12/2
b ] Enterprise Trus Trouter/ Cut ENF’W"-I-- 20
» _:"I Intefmedlatelc Y ltunnel, Copy tunnel/cs1-pd1 1/3/20
: g Lr::r:je:u:ﬁ ¥oltunnel, Il}ehte tunnel/cs1-pd1 6/12/2
b (] Third-Party Ro  Properties
p (] Trusted People Help
b Client Authent
b | Remote Desktc
b
I

47. Select your GUID certificate with the friendly name of vdm.ec.
+ Right-Click select All Tasks
+ Select Export

&= Certdicate Export Wizard

' Welcome to the Certificate Export Wizard

This wizard helos you copy certificates, certificate trust lists and certificate revocation
=tz from a certficate store to your dhsk.

A c=riificate, which & msued by & certfication autharily, is a confirmation of your identity
and contans iInformaton used to protect data or to establish secure network
cormechone. A osrlificate ctore is the system area where cerbficates are kapt.

To oontmue, dick Next.

48. On the Welcome window
+ Select Next

Installing and Configuring Horizon TRUESSO Export Date: 2023-05-24 07:29:01 Page 58
-0600



# &~ Certdicate Export Wizard

Enpast Privale Key
Yo can choose bo expor] the privale key with the certificate,

Provate heys are password protected, IF you want to export the private key with the
cerbificate, you must tyoe & password on & later page,

Do you want to export the private key with the certficate?
() ves, export the private key

()Mo, do not =xport the prvats key

49. On the Export Private Key page

+ Select the radio button next to No, do not export the private key
+ Select Next

* £* Certdicate Export Wizard

F gl File Fiss rnaall
Qe Sficates can be exporbed in 8 varely of fie formals,

Select the format you want to use!
_VDER encoded binary X509 (.CER)
W) Base 54 encoded ¥ 509 [, CER)

CrCryptographc Message Syntax Standard - PKCS £7 Certificates (P 78)

tmdude ol cerhSmates nothe certBcanon path iF posshie
Personal Information Exchange - PRCS #12 (PFX)
Erchite all corfibeates i the cartification cath if possils
Deiete the private key if the export is successfil
rt ll extended properties
Enable certificate privacy
Moz ool Seislize Certificale Store (55T

50. On the Export File Format window
+ Select the radio button next to Base-64 encoded X.509

Installing and Configuring Horizon TRUESSO Export Date: 2023-05-24 07:29:01 Page 59
-0600



+ Select Next

& & Certdicate Export Wizsrd

Film by Empes|
Somcify the rame of the file you want 1o export

Flie name:
| Erteofmare Honzon ol cer | [Erowse..

51. In the File to Export window
+ Under File name type the following E:\software\Horizon\enroll.cer
+ Select Next

(Software is a shared folder which we will use to copy from on the TrueSSO server)

Completing the Certificate Export Wizard

You have successfily completed the Certrfcate Export wizard.

You have specfed the folovang settings:

Export Keys L]
Inchude al certificates in the certification path N
Fie Format Easet4 Encoded X, 509 (".cer)

The export was successful,
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52. Onthe Completing the Certificate Export Wizard window
+ Select Finish. When prompted that The export was successful,
+ Select OK

LE TrueSSO - TrueSSO.euc-live.. L Horizon - horizon.euc-liv...

53. On your ControlCenter server desktop
+ Switch from your Horizon RDP session to your TrueSSO RDP session

@ Console1 - [Console Root\Certificates (Local Computer)\VMware Horizot

@ File Action View Fevorites Window Help

e« 2w 0 cz Bl
Console Root Object Type
4 g Certificates (Local Computer)
There are no it
d Personal
Cerificates
Trusted Root Certification Authonties
Enterprise Trust

Intermediste Certification Authorities
Trusted Publishers
Untrusted Certfficates
. Third-Party Root Certification Authorities
Trusted Pecple
Client Authentication |ssuers
Remote Desktop
Certificate Enrollment Requests
Smart Card Trusted Roots
Trusted Devices
Whiware Horizon View Certificates
_ WWhware Horzan View Fnmllment Server Trusted Roots

Find Certificates...
Al Tasks ¢ Find Certificates...

View ¢ Import...

New Window from Here ~

Add a certificate t

New Taskpad View...

Refresh
Export List...

Help

54. On our TrueSSO server
+ Select your Certificate services Snap-in,
+ Select and right-click the last container in the inventory VMware Horizon View
Enrollment Server Trusted Roots,
 Select All Tasks > Import
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&= Certificate Import Wizard

I Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust kists, and certificate revocation
ksts from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

Store Location
Curent User

Local Madchne

To continue, dick Next.

.

55. On the Welcome window select Next

€ & Certificate Import Wizard

File to Import
Spedify the file you want to import.

Fie name:
[ Worizon.eucdvefire. com\software Horizon\enrol. cer Browse, ..

MNote: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P75)
Microsoft Seriskzed Certificate Store (.55T)

o] | cance

56. In the File to import window
+ Under File name, type the following \\Horizon.euc-livefire.com\software\Horizon\
enroll.cer
+ Select Next
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() - Centificate Import Wizard

Cortcate store
(Cartcate soves ve system areas where cerbfcates re ket
Widons can autamaticaly seecta certficate store, or you <an specfy 8 ocatn for
e,

Automatialy ceect the cerbfate tove baced on the tyoe of cartfate
® Place o cartcates i the folowng siore
Certhate stre:

"Minare Honzon Ven Evolment Seves Trusted Roots Browee

& & Cenificate Import Wizard

Completing the Certificate Import Wizard

The certificate wil be imported after you dick Finish.

You have specified the following settngs:

I TIUEs] vMware Horizon View Ervoliment Server Trusted Roo
Content

Certficate Import Wizard x

57. In the Certificate Store window accept the defaults and

+ Select Next.

+ On the Summary page select Finish.
+ When Prompted that The Import was succesful select OK

58. In the Certificates Folder
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Fie Acion View Favorites Window Help
W am &L XE=R Bm
Console Roct Issued To “ Issued By
o Centificates (Local Computer) (55 47815094-9c -y a -4
4 ) Personal Open
Certificates All Tasks »
Trusted Root Certification Authorities
Enterprise Trust =3
Intermediate Certification Authorities Copy
Trusted Publishers Delete
Untrusted Certficates 5
Third-Party Root Cetification Authorities —
Trusted People Help
Client Authentication Issuers
3 (] Remote Desktop

Certificate Envollment Requests
Smast Card Trusted Roots
Trusted Devices
] VMare Horizon View Certificates
VMare Horizon View Enroliment Server Trusted Roots
Cenificates

47815094-Scc2-4f00-a7f5-30dcS 101 tdcentss.. | ? IS
Genersl | Cross Certfcates | OCSP | Extended Valdation

Friendly name: ‘van.td

Descrption:

Certficate puposes.

® Ensbie sl purmoses for ths certifcate
Disale al purposes for this certificate

O Ensbie only the followng purposes

Note: You may only edit certificate purposes that are alowed by
the certification path.

Server Authenbication

Clent Authentication

Code Siging

Seare Emal

Time Stampng

Marosoft Trust List Sgning

Marosoft Time Stampng A
< w >
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Right-click the imported certificate

Select Properties.

In the Friendly name: section type vdm.ec
Select OK

® Workspace ONE™ Access

Dashboard - Users & Groups Catalog - Identity & Access Ma

Web Apps
Virtual Apps

Virtual Apps (TR

Settings

[ 1o conturation

59. Switch to your browser, Workspace ONE Access Saas session,
 Select the Catalog tab > Virtual Apps Collection

@ Workspace ONE™ Access

Dashboard « Users & Groups Catalog ~

s Collect]

SYNC l E

Virtual A

Name Source Typs

© Horizon Horizon

60. Select the radio button next HORIZON
+ Select EDIT

Installing and Configuring Horizon TRUESSO Export Date: 2023-05-24 07:29:01 Page 64
-0600



Edit Horizon Collection

1 Connector ) ) )
Add or modify pods. If a pod has multiple Horiz

information for any of the Horizon Connection !
2 Pod and Federation

3 Configuration Horizon Connection

Server Username
4 Summary Horizon.euc- administrator@euc-
livefire.com livefire.com

(¥ ADD A POD

Have you enabled Cloud Pod Architecture for

f—‘ iy
61. In the Edit Horizon Collection window,
* Select 2 Pod and Federation,
+ Under Horizon Connection Server
» Select Horizon.euc-livefire.com
o - |

CANCEL | BACK NEXT

Pod and Federation

Cloud Pod Architecture (CPA)
Disabled

Configuration

Qune

CANCEL | BACK SAVE

62. Inthe Edit Pod window under True SSO, change the toggle from Disabled to Enabled
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Select SAVE ,
Select NEXT,
Select NEXT,
Select SAVE

4 VIhware, Inc.
, WMware Drivers

b VMware Tools
al Vi wpes DAL
| Al Collapse
;L Mew
N Find...
b P
Viw Delete Binary Value
S Wowb43| Rename DWORD (32-bit) Value
b~ b SYSTEM Export QWORD (64-bit) Value

b - . HKEY_USERS
- ). HEEY_CURREMT
P rs Policies
RegisteredApplications

Permissions... Multi-5tring Value
Expandable String Value

4 Vhthware, Inc.
. VMware Drivers
- VMware Tools
4 Vhiware VDM
. Authenticate
, Leg
- Node Manager
B - ). Plugins
[Enroliment Servicd |
i . Viware VGAUth
[ WowbB432Node
L o). SYSTEM
b | HKEY_USERS

T T

63. On the ControlCenter server, switch back to your TrueSSO.RDP session
1. Select the Start button > RUN and type regedit.exe
2. Inthe regedit inventory, browse to the following location, browse to
* HKLM\SOFTWARE\VMware, Inc.\VMware VDM\
+ What we should see is an Enrollment Service Key
* HKLM\SOFTWARE\VMware, Inc.\VMware VDM\Enrollment Service.
*+ You will notice there is no Enrollment Service key, we need to create one. In our
case we have to

3. Create the Enrolilment Service key
*+ Right-click VIMware VDM > New > Key and type Enrollment Service as a name
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64. Configure the enroliment service to give preference to the local certificate authority when

they are co-located:
+ Add a new String Value
* Right-click the Enrollment Service key > New > String Value and type the name
PreferLocalCa
* Right-click the PreferLocalCa String value and select Modify and in the Value data:
field enter 1
+ Select OK to close the window.

Edit String X

Value name:

| UseKerberos Authentication ToCa |

Value data:

o |
Cancel

65. Add a new String Value (this is to rectify a bug in 2111)
+ Right-click the Enrollment Service key > New > String Value and type the name

UseKerberosAuthenticationToCa
* Right-click the UseKerberosAuthenticationToCa String value and select Modify and in

the Value data: field enter false
+ Select OK to close the window.
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Edit String

Value name:

| UseNTLMAuthenticationToCa

Value data:

I LB

[0k ]| Cancel

66. Add a new String Value (this is to rectify a bug in 2111)

+ Right-click the Enrollment Service key > New > String Value and type the name

UseNTLMAuthenticationToCa
* Right-click the UseNTLMAuthenticationToCa String value and select Modify and in the
Value data: field enter true
+ Select OK to close the window.

4 Serdices

File Action WView Help
s E d = B re o

2. Seraices (Local)

. Senvices [Local)
Whware Horizon View Enrollment
Server

top the service
Restart the service

Description:
Provides Horizon View Enroliment
Server services.

Name

1 Virtual Disk
1 Vbware Alias Manager and Ticket Service

\"_';'|'~'hh'm Snapshot Provider Ciart

15 Vhbware SYGA Helper Service Stop

G

-,,!-_'«'h.hwe Tooks Piaieta

S Volume Shadow Copy Restrre

15 WalletSendce =
:s;_.:w"p"'r\sw Restart

(54 'Web Account Mansger All Tasks 3

C:j'ﬂ'mduws fudio

{5 Windeows Audic Endpaint Buile Refresh

5 Windows Biometric Service Properties
C.j'l\'ln-duws Camera Frarme Sercer

{5 Windows Connection Manages Help

-,'-:;-': ‘Windows Defender Advanced Threat Protection Service
15} Windows Defender Antivirus Network Inspection Service
15 Windows Defender Antivirus Senvice

-S;-': ‘Windows Defender Firewall

r oA s oan s

67. Onyour TrueSSO server
« From the Start button, select Run
+ Type services.msc and select OK
« Scroll down to VMware Horizon View Enrollment Server service in services menu

+ Select and right-click the VMware Horizon View Enrollment Server service

+ Select Restart

+ Close the Services mmc
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LB TrueSSO - TrueSSO.euc-live.. LCf§ Horizon - horizon.euc-liv...

68. On your ControlCenter server
+ Switch to your session

Programs and Features
Power Options

Event Viewer

System

Device Manager
Network Connections
Disk Management

Computer Management

Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

= &5

69. Select and right-click the button
+ Select
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BX Administrator: Command Prompt

70. In the Administrator: Command Prompt type the following:-

* cd "\Program Files\VMware\VMware View\Server\tools\bin"

71. In the Administrator: Command Prompt type the following:-

The enrollment server is added to the global list.

vdmUtil —--authAs administrator --authDomain euc-livefire --authPassword VMwarel! --

truesso —--environment --add --enrollmentServer TrueSSO.euc-livefire.com

inistra

72. Wait 2 min before doing the next command

In the Administrator: Command Prompt type the following:-
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The output shows the forest name, whether the certificate for the enrollment server is valid,

the name and details of the certificate template you can use, and the common name of the
certificate authority.

vdmUtil --authAs administrator --authDomain euc-livefire --authPassword VMwarel! --

truesso —--environment --list --enrollmentServer TrueSSO.euc-livefire.com --domain euc-—
livefire.com

yaresvMware

73. Enter the command to create a True SSO connector, which will hold the configuration
information, and enable the connector.

vdmUtil --authAs administrator --authDomain euc-livefire --authPassword VMwarel! --
truesso --create --connector --domain euc-livefire.com --template TrueSSOTemplate --
primaryEnrollmentServer truesso.euc-livefire.com --certificateServer euc-livefire-
TRUESSO-CA --mode enabled

74. Enter the command to discover which SAML authenticators are available

Authenticators are created when you configure SAML authentication between Workspace ONE
Access and a connection server, using Horizon Administrator.

The output shows the name of the authenticator and shows whether True SSO is enabled

vdmUtil --authAs administrator --authDomain euc-livefire --authPassword VMwarel! --

truesso --list —--authenticator
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75. You will notice True SSO mode is Disabled. Enter the command to enable the authenticator
to use True SSO mode

vdmUtil —--authAs administrator --authDomain euc-livefire --authPassword VMwarel!

truesso --authenticator --edit --name "Workspace ONE Access" --truessoMode ENABLED

For --truessoMode, use ENABLED if you want True SSO to be used only if no password was
supplied when the user logged in to VMware Identity Manager. In this case if a password was
used and cached, the system will use the password. Set --truessoMode to ALWAYS if you want

True SSO to be used even if a password was supplied when the user logged in to VMware
|dentity Manager

Part 6: Testing to see if TrueSSO works

ViMware Workspace ONE Access™ 20.01.0.0 Build 15509389, Copyright @ 2013-2020 YMware, Inc

as well as by international treaties. VMware products are covered by one or more patents listed at hif)

C% w10TRUESSO - wlOTRUESSO.eu... L TrueSSO - TrueSS0.euc-livefire....

1. On your ControlCenter server, switch your session for
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& W10Client02 - W10Client02.euc-livefire.com - Remote Desktop Connection

B ﬂ‘ ) Apps | Intelligent Hub X l-l— L
« - 0O @ &

httpsy/aw-livefirehorizonintm.vidmpreview.com,/catalog-p

N

2. Onyour W10Client01 desktop, ensure that any existing browser session is CLOSED
+ Open your browser and type enter your custom Access Tenant URL

Select a certificate for authentication ’

Site casvidmpreview.com:443 needs your credentisls

Q demale.stritec

Certificate information “ Cancel

3. Onthe Confirm Certificate window, select OK
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L) inteligent Hub x +
8 aw-livefiredrassoir,vidmpreview.com/catalog-portal fuiTisOnPr

¢ C
Notifications

I’ ‘l Favorites

Search apps

Categories

All Apps
Virtual
New
4. Select Apps tab in the Console
Q) Apps | intelligent Hub x + [+] B o |
& C (0 & aw-livefireengeimvidmpreview.com/catalog-portal/ui®/apps T &
i Apps Reading lis
J Favorites Apps People For You Support AM
Q Search Apps
New Apps All Apps Calegories v
A=

‘WordPad

\ 4
W1DINST

Calculator Internet Explorer
ey wre 2 Honizon e = Horizon

BambooHR
2 Horizon

0w

New Apps
e
.48

= Horizon

Website

5. In the Web based Intelligent Hub
* In the Apps area, under New Apps select Wordpad
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6. Onthe W10Client01

+ Launch the

© Apps | mligent sl x + °
€c2CcO & ;
[ e 2 Jist
- ¥
:’ Horizon (| = L]
; ] _.. |‘f
Runn ng ﬂ”‘, .""' i Editing
g Windows Word :
* Note your WordPad session launch
desktop pool
+ If this is not the result, move on to Step 8
0 | O Apps| inteligent Hub o G & Hor
oS

<;: tt hornzon.euc-livefire.com,

demale striteo

The attempted 109060 1s invalid. This IS Sither duete'a bad username or authentication.
information.“An untritsted certificate authority was detected while processing the certificate
used fof SUthentication.

[l

7. This might be the result. If so, move on to Step 8
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+ As we mentioned early, for VMware Horizon Enrolment services to work, it critical we
have a Healthy Certificate Services environment.

« Also an environment where our new sub-ordinate CA is trusted on all servers.

« The Servers we are concerned with are the Horizon and Control Center servers

A B Administrator: Command Prompt

8. On the ControlCenter server
* Open the Command Prompt on all stakeholder platforms and type the command
GPUPDATE /Force
* Repeat this same task on the Horizon server

You are now ready to again test your login through Workspace ONE Access. If necessary go
back to Paragraph1 and repeat the login process

0 Intelligent Hub X VMware Horizon x +

C @& cs1-pdl.euc-livefire.com/portal/webclient/indexhtm ?desktopld =cn330w10instou%3 Dapplications,dc¥3Dvdi dc%3Dvmwa... ¥ e :

Enable Copy and Paste

You can copy and paste text between your local system and
the remote applications using Ctrl + C and Ctrl +V

9. Launch another session from the Workspace ONE portal and launch your Desktop
entitlement.
* This should be the result
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10. Launch another session from the Workspace ONE portal and launch an

entitlement.
*+ This could be the result, | have just launched Calculator and WordPad
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